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Note to v.1.0-v.1.0.3 users
Due to the vast differences between Digital Messiah v.1.0 and v.2.0 it 

will be impossible to offer an upgrade package for v.1.0. users.  The entire 
package must be obtained through a shareware source or direct from 
Terminal Sunset Software.  I am truely sorry for this inconvenience, but it 
was unavoidable.  If you are a registered user of Digital Messiah v.1.0 you 
will recieve information on obtaining free v.2.0 registration.

Requirements
Digital Messiah requires an 8-bit (256 color) 13" or greater monitor 

running on a Macintosh using System 7.0 or higher.  Without the ambient 
sound extension it takes approximately 2.7 megs on disk (with the ambient 
sound it is about 3.6), and 2600K free RAM.  Users with larger monitors may
have to increase the memory partition.

Memory 
2600K is a fairly large partition for an application to demand.  If

you own a 4 or 5 meg machine and cannot run Digital Messiah, you 
may use System 7's virtual memory feature.  Due to its modular 
nature, the program works very well under virtual memory.  In v.2.0 
every attempt has been made to provide for a friendly exit when the 
program runs out of memory.  Digital Messiah will try to throw up a 
suitable dialog if this occurs, at this point you should increase the 
memory partition in the Get Info... dialog box of the application.

Extension Conflicts 
Although Digital Messiah has under gone much testing, it is 



impossible to solve every extension conflict.  If you experience 



problems with the game crashing, please try running without extensions.  If 
you find a conflict, please e-mail or snail-mail a bug report so that I may 
resolve it.  Additional information can be found under DM Bug Reports.

Ambient Sound
Originally intended for commercial distribution, Digital Messiah is of 

an enormous size decompressed.  The full version takes over 3.6 megs and 
would find the normal means of shareware distribution awkward and time-
consuming.  To facilitate its distribution I have divided the application into 
two parts.  The first of which is the Digital Messiah application; the second is
the Ambient Sound Extension.

The Ambient Sound Extension can be installed with the DM Ambient 
Sound Installer (which may be obtained from a shareware source or direct 
from Terminal Sunset Software).  Ambient sound is a collection of 
approximately 1 meg of high-resolution  sound-effects which play at random 
moments during game play.  It adds to the realism and suspense of the 
game, bringing the world of Digital Messiah to a new dimension.  The 
sounds have been optimized to take advantage of the full range of 
frequencies available to an externally amplified sound source.

About
Digital Messiah is an arcade/role-playing game that combines vivid-

hand painted and rendered graphics with digitized sound and music to 
create the ultimate gaming experience.  The maps and plot for each game 
are generated randomly to provide for infinite playability.  Your character is 
equipped with 6 different spells spanning up to 6 levels.  The enemies you 
will face are preprogrammed with a variety of strategies ranging from the 
Wanderer to the Stalker.  An automatic mapping feature and wandering non-
player characters will help you on your way to saving the world.

About Player v.4.9 Pro
Player v.4.9 Pro is a fully featured mod player/writer available from 

Antoine Rosset.  You may contact him at Antoine Rosset/16 Tranchees/1206
Geneva/Switzerland.  The program may also be obtained from America 
Online and various other shareware sources.

Objective
The object of Digital Messiah is to destroy the evil Emperor Kang and

vanquish his technologically inhumane reign.  Each of the four Elementals 
and the Pope (housed at the Elemental Palaces and the New Vatican 
respectively) will ask you to perform several missions.  After completing 
these quests, return to their lair and they will reward you with spells and hit 
points.  Through continually harder trials, they will test your worthiness and 
eventually reward you with the tools needed to defeat Kang.  Along your 
way, each of the five Sages and numerous Non-Player 



Characters will offer you the knowledge needed to survive the post-Kang 
world.  Good Luck...

Getting Started
To start Digital Messiah just double-click (open) the icon.  Note:  Your 

MAIN monitor must be set at 256 colors in order to run DM.  To do this go 
into your Control Panels folder and open Monitors.  If your system is capable
of 256 color graphics, the option will be given.  The following introduction will
provide you with enough help to get you on your way.  However, Digital 
Messiah is an exceedingly complex game and to gain the most out of it one 
must read the more in-depth sections of this manual.

Quick Help - (The Duel)
If this is your first time playing, the Duel option will help you get your 

bearings.  In The Duel, you battle an opponent using the spells and difficulty 
of your choice.  To begin a Duel:

1) Select an opponent from the Opponent menu (there are seven 
listed in descending order of difficulty) 

2) Set the FPS rate to suit your gaming taste and machine capability.
3) Select Duel from the File menu
4) Select up to four spells (see below for details)
5) Start pushing buttons!  (The buttons which control the Digital      
Messiah are listed and configured using the Controls item in the 
Options menu).

Quick Help - (The Game)
The Game weaves a fully functional random world into the plot of 

Digital Messiah.  You will Duel enemies of varied intelligence and power as 
you work your way through twenty quests. To begin your journey:

1) Set the FPS rate to suit your taste and machine capability.
2) Select New Game from the File menu (this may take 
awhile...map generation is no simple task)
3) You will be placed due north of the New Vatican.  Click the zoom 
box (far right of title bar) if you wish to make the map full screen; you 
may scroll around freely.  To move use  the configured keys.  Enter 
the New Vatican and your  quest shall begin!!!

Combat
Combat is relatively simple -- it pits you and one of the seven different

enemies against each other in real-time battle.  As the Digital Messiah you 
are armed with an endless cache of Fireballs and a given amount of spells.

The keys used in Combat are set using the Controls item in the 
Options menu.

There are two windows in Combat, the Battle window and the Status 
window.  The Battle window, quite simply, contains a visual display of the 



battle and the Status window includes information on your hit points, the 



enemy's hit points, the selected spell (and its level), and your level of 
regeneration.  The amount of hit points till death is marked in blue drops of 
blood, while the amount of hits taken is marked in red.  The selected spell is 
framed by a red box (blue if currently in use), and its respective level is 
written to the very left.  The level of regeneration is marked using a violet bar
of varied brightness.

The Digital Messiah is armed with two weapons when in combat.  The
first of which is his cache of fireballs which may be fired when your 
regeneration is at its highest level.  Aiming is simple, your enemy must be in 
a direct line of fire.  Each of Kang's minions is equipped with different spells 
and capabilities, it is necessary to study each as a separate opponent and 
not acquire a single strategy of attack for the entire range of Kang's forces.

The second is the Digital Messiah's arsenal of spells.  Each spell has 
a separate mystical effect based on the type and level of spell cast.  More in-
depth information on your spells may be found under Spells.

Enemies in Combat

As you begin your quest in the world of Digital Messiah you know little
or nothing about your enemies.  The only way to gain further information 
about their strategies and powers is to speak with wandering non-player 
characters.  These characters are discussed later under Non-Player 
Characters.

The World

The Terrain
When you begin the full game you are placed on a 100x100 map 

which is filled with randomized pools of liquid waster, barbed wire fences, 
metallic plains, and cities of dream palaces..  The only square, however, 
which is accessible to you is Metal Plate.

Among the mechanized terrain of the world, there are four pools each
consisting of one of the elements (fire, water, earth, and air), that surround 
the Elemental Palaces (for further information see below).

The Kingdom

The New Vatican - This is where you begin your quest.  The building 
harbors the Pope who will aid you most along your quests.  He offers you 
MindBlast and Regeneration spells.

Elemental Palaces - These castles, protected by a moat of one of the 
elements, harbor the Four Elementals.  They will reward you with Fire, 
Earth, Air, and Water spells in return for your aid.

Fortresses - The strongholds of Kang house his greatest warriors.  They 
build and train the latest designs of cybernetic soldiers; to attempt to destroy
one of these simply enter it and a battle fiercer than you have before known 
will ensue.





Dream Palaces - It is said that through these structures, Kang is able to 
harness his dreams into reality.  Although they are of no threat directly, they 
serve has Kang's chief aid in terrorizing the people of Earth.

Emperor Kang's Palace - It is here that you will find the demonic Emperor 
plotting for the next day.  No one has ever lived to enter the great castle, but 
many have told of four mysterious slots in its gargantuan door.

Searching
You will, when told to find a lost artifact, be required to search a 

particular square on the map.  To do this press the search key (configured 
under the Controls item); if there is anything of importance to be found you 
will automatically pick it up.

Spells
As the Digital Messiah enters battle, a selection of four spells may be 

equipped to use in combat.  The spell grid is used to equip each spell.  It 
covers the entire range of spell types and levels keeping track of all spells 
acquired.  In descending order the type of spells are:

MindBlast (sphere with red beams): Does 1 -5 points of damage to 
your enemy.  The amount of damage is based directly on the level.

Regeneration (sphere with green beams):  Heals 1 - 6 points of 
damage.  The amount healed is equivalent to the level.

Fire:  Makes the Digital Messiah's fireballs move twice as fast and do 
twice the damage.  The duration of the spell is 2 times the level in seconds.  
Therefore a level 3 fire spell would last 6 seconds.

Water:  Freezes your opponent rendering him defenseless, the spell 
ceases his movement and firing but does not make him incapable of casting 
spells.  The duration of the spell is determined the same as Fire.

Earth:  Provides a universal shield for the Digital Messiah making you
momentarily impervious to all attack.  The duration is, once again, 
determined the same as Fire.

Air:  Enables the Digital Messiah to warp from his current location to a
point directly under his enemy.  The level determines the amount of time the 
spell may be cast in a single battle round.

One should note that a range of spells is provided because different 
spells are needed to vanquish different enemies.  One should not become 
dependent upon a certain spell.

Sages
The Sages of the Digital Messiah world are your sole aid in 

completing the twenty missions given to you.  In return for the knowledge 
they offer, you must complete missions of increasing difficulty.  The wisdom 
they impart is always key in solving a certain mission and never, in any way, 
useless.  Each of the five Sages is permanently highlighted on the Auto-
Map.

Non-Player Characters



Non-Player Characters comprise the population of the Digital 
Messiah world.  These people or survivors of the Great Technological 
Holocaust and through the narration of their experiences they impart 
valuable knowledge.  Almost every aspect of the game is covered in their 
narrations.

Digital Messiah - Menu by Menu

the Apple Menu
About Digital Messiah  - This will give you information on how to 

register your copy of Digital Messiah .  Registration will make you the legal 
owner of Digital Messiah, as well as provide you with upgrades, bug fixes, 
and new release information.  You will also have the opportunity to play test 
Terminal Sunset's new software.  See DM Registration for more details.

the File Menu
New Game - Start a new game.
Open Game - Open a previously saved game.
Duel Opponent - Duel the opponent currently selected in the 

Opponents menu.
Close Game - Close the game currently in play.
Save Game - Save the game currently in play.
Save Game As... - Save the game currently in play as xxx.
Resume Game - Resume a paused game.
Quit - Go Bye-Bye!

the Options Menu
Sound - Raise and lower the volume.  Select which 

category of sound is on or off.  The categories 
are the following Ambient, Walk, Battle, and 

Music.  Ambient sound is an extension to 
Digital Messiah which may be installed using 

the DM Ambient Sound Installer.  For further 
information see Ambient Sound below.  Walk 
sound is the clicking noise heard when Digital 
Messiah is making a step.  Battle sound are 
the sound-effects played during the arcade 
battle sequences.  Music is the intro music 
played when a game is not currently open.
Controls - Configure the keys to use in Digital Messiah.  

Note that all keys on the keyboard (except for 
the power key) may be mapped.  The only key 

which may not be used is the ESC key which is
used as an alternate pause button 

throughout the game.



Preferences - Using this dialog box you may change the fps 
rate.  The fps (frames per second) rate is a 
measure of how many times Digital Messiah 

will render an animation per second.  As most 
TVs run at 60fps, Digital Messiah may run at a 
user-definable 30-60fps.  The fps simply 
changes the speed at which the game is 
played and is limited only by your machine 
capability.
AutoMap - View the AutoMap.  Details are given below.
Statistics - See how you are doing (see below for details)

the Opponents Menu
In ascending order of difficulty this menu lists the available 

opponents.

the Intro Menu
Stop/Continue - Pauses and continues the intro 

sequence.
Next - Prematurely advances to the next  screen.  

Clicking the mouse button in the Intro window 
will have the same effect.

Intro Screens - (e.g.. Welcome, Terminal Sunset, etc.) 
will prematurely advance to the chosen 

screen.

The Auto-Map
The Auto-Map is an automatic mapping feature which will record 

everything you see or are told.  The hints which the Sages give often involve
some location given in coordinates, these locations are subsequently 
highlighted in the auto-map.  To target on a location and find out exactly 
what it is simply click in the square and a textual description will be given at 
the bottom of the map.

Statistics
Name - Your name.
Hits - Hits taken/Total hits allowed.
Score - Your score to date (goes up AND down, 

depending upon your performance in battle).
Coords - Your current coordinates on the 100x100 map.  

0, 0 being the northwest  corner; 99, 99 being 
the southeast.

Facing - The direction which you are facing.

Missions
The missions you have been given by the Pope and the Four 

Elementals.



Spells
The spell grid.  The spells which you have (and which are equipped) 

and their levels.

Inventory



What you currently possess and which of the four Elemental Keys 
you have obtained.

Tips and Tricks

• DON'T use your spells sparingly.  You'll get many more, and your are 
better unarmed than dead.

• Try to learn what the enemies do during Battle, some of them are very 
predictable.

• Pick and choose your Battles.  Generally, you won't have to fight 
someone...so don't if you can't.  Remember the enemy difficulty 
increases as you complete more and more missions, so be careful in the 
later levels of the game.

• Never get too close to your enemies on the Map.
• Learn how to run from enemies.
• Use the sages to the best of your advantage.  Even if their information is 

useless...their rewards aren't.
• The Auto-Map is the most powerful feature of Digital Messiah.  It records 

everything that you need to win the game as well as other information 
necessary to survive. 

• The Non-Player characters will give you in-depth detail about your 
enemies, and it would be a poor decision to enter into battle with a new 
enemy before listening to their tales.

• NEVER underestimate an enemy...just as you thought the Battle was 
over, he can begin to launch several brutal spells.

• Stay alive!

You can reach me at:
Ravi J. K. Mehta
400 High Point Drive Apt #410
Hartsdale NY  10530

or e-mail me at:
AOL ---> TSunset
Internet ---> tsunset@aol.com
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It is hereby proclaimed that the author of this software shall in no way be liable for damages 
caused by the use, misuse, or abuse of this program.  The characters in this story are fictional, 
any similarity between persons living or dead is purely coincidental.  This software along with all 
its respective files and docs may be distributed freely across ANY media.  It may not however be 
altered in any way.
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